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Read instructions before use. 

 

Type BF equipment (applied parts): 
Metal parts connected to chassis of computer may contact 
user.  Compliance with 601-1 medical equipment standards 
requires use of a medical grade power supply. 

 

Entela Safety Mark: Compliance of this product with UL 
2601-1, CSA C22.2 N0.601.1 and IEC 60601-1 is certified 
by Entela, an independent testing body. 
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1. Introduction  

Congratulations on your purchase of an EyeLink II! 

The basic steps in installing the EyeLink II system are: 

1) Unpacking and Installing the EyeLink II Hardware. This includes placement of 
all of the EyeLink II components, setting up the Host PC, Display PC (optionally 
purchased through SR Research) and connecting them together via an Ethernet 
cable. 

2) Installing the EyeLink II Display Software (API and example experiments) on the 
Display PC and configuring it for use (if not purchased through SR Research). 

3) Installing the necessary Operating System and EyeLink II Host Application 
software on your Host PC if this has not already been done.  

4) Testing the installation. 

Most new acquisitions of the EyeLink II include a preconfigured Host PC requiring 
simple setup and the attaching of cables (Steps 1, 2 and 4). This would take about 1 
hour to set up. If you need to perform Step 3 as well then expect about 2 hours of work.  

 

 

Figure 1-1: Suggested EyeLink II System Layout 
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1.1 Suggested Equipment Layout 

The layout of the EyeLink II equipment is important if participant setup is to be 
convenient, and lighting problems are to be avoided. Before setting up equipment, 
check the arrangement of the room to be used against these suggestions. These will aid 
in the production of good experimental data. 

• Set up the Host and Display PC monitors on tables arranged in an ‘L’ shape, as in 
Figure 1-1. This configuration allows the experimenter to set up the headband and 
the participant’s left eye camera, while having access to both computer keyboards 
and monitors. 

• Avoid windows or other bright light sources that could cause reflections on the host 
and display monitors. Windows or incandescent lights on the walls behind or near 
the display monitor may interfere with the head-tracking camera. The grey walls 
highlighted in Figure 1-1 are locations where bright light sources will cause 
reflections. 

• Supply sufficient light in the room. Dim rooms cause participant’s pupils to dilate, 
which can cause setup problems with some participants. The best way to light the 
room is with ceiling-mounted fluorescent lights, above and no more than 2 meters 
behind the computer monitors. Painting the walls light colors or white will maximize 
ambient light as well. 

• Avoid environmental distractions. Be sure the room can be kept quiet, that no 
posters or other items are on the wall seen by the participant, and so on. It is also a 
good idea to make sure the participant cannot see the host monitor, without turning 
their head (discourage this). 

• Supply a comfortable, stable chair for the participants. It should not wobble or move 
when sat in, and the back should be firmly attached to the seat--springiness 
encourages some subjects to rock forwards and back. A chair with a concave back 
and seat also discourages shifting of the body, as does a high back. The top of the 
chair back should be just below the shoulders on an average participant. Finally, 
make sure participants can enter and leave the chair easily, as the chair will be close 
to the table with the Display PC monitor. A fixed base reclining dental chair has 
proven to be an ideal participant and EyeLink II friendly chair.  

• Set up the Display PC monitor and chair so that the participant’s eyes will be at a 
distance from the monitor of about twice the width of the display area of the Display 
monitor. This distance gives a display area of 28° by 22°. This standard distance is 
assumed in all EyeLink II documentation: while the EyeLink II system can measure 
and compensate for the eye-to-display distance, this is the ideal distance for both 
calibration accuracy and head-motion compensation. 
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1.2 Host PC Installation 

After setting up the Host and Display PCs at the desired locations (see Section and 
Figure 1-1 for a suggested layout) you are now ready to start assembling the EyeLink II 
components and installing software on the Host and Display computers.  

You should have the following components on hand: 

1. EyeLink II PCI card 

2. EyeLink II Headband 

3. EyeLink II infrared markers plus cabling 

4. crossover Ethernet cable to connect Host and Display PC together 

5. EyeLink Button Box 

6. optional Analog Card if purchased (if purchased) 

If your EyeLink II has a preconfigured Host PC then continue to 
 Section 1.3 Host PC Hardware Installation to begin attaching cables. 

1.2.1 Host PC Hardware 

This section discusses Host PC hardware for users who did not receive a preconfigured 
system or who need to replace the Host PC computer.  

The PC that hosts the EyeLink hardware and software must meet certain specifications 
due to the nature of the operating system that the EyeLink Host application runs 
under. As computer technology is rapidly changing, only systems tested and approved 
by SR Research Ltd. can be guaranteed to work.  

In the interest of not instructing our customers to purchase computer equipment only 
to encounter difficulties with their installation, the reader is directed to consult the web 
page http://www.sr-research.com/compatibleHostPCs.html for a list of systems known 
to be compatible and accurate when running the EyeLink hardware and software. 

If your EyeLink II system did not come with a preconfigured Host PC, or if you are 
upgrading or replacing your original Host PC, you should have the following additional 
components on hand. The software components were supplied with your original 
EyeLink purchase:  

1. any tools required for accessing your Host PC’s case (usually a Phillips 
screwdriver will do) 

2. “SR Research EyeLink II” CD 

3. “ROM-DOS Boot CD” 
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Depending on the operating system that is to be used on your Host PC’s non-EyeLink 
partition, you may require the following: 

4. “System Commander Boot CD” – originally supplied for customers using 
Windows NT/2000/XP on their Host PCs; not required for Windows Vista (see 
Appendix B). 

1.3 Host PC Hardware Installation 

IMPORTANT: Switch off the PCs before connecting or disconnecting any 
cables, especially the headband connection! Ensure that the headband cable 
is properly connected and connectors are properly secured to the Host PC 
and the headband before use. 

Ensure that the power supply setting on the back of the PC (Near the 
power jack) matches your local supply voltage! 

 
Open the shipping case.  If the system has been stored or transported at a temperature 
below 10°C, allow all parts to warm to room temperature before proceeding. 
 
Please save the shipping and packing material for storage or in case the unit needs to 
be returned for repair. 

1.3.1 Insert EyeLink II PCI Card(s) 
If you did not receive a preconfigured Host PC, you will have an EyeLink II PCI card 
(and possibly an optional Analog Card) that needs to be inserted into the Host PC. If 
you see the card pictured in Figure 1-2 installed in the back of your Host PC then 
continue to Section 1.3.3 Headband Installation. 
 
Open the EyeLink II Host PC, and insert the EyeLink II card (pictured below) into a free 
PCI slot. It is recommended that an open slot be left on one side of the card (preferably 
on the side with the large space). Ensure the bracket is firmly attached to the PC with a 
screw. 

 

Figure 1-2 EyeLink II PCI Card Connectors 

IMPORTANT: Do not insert VGA monitor cable into Marker connector. 
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1.3.2 Installing the Data Translation Analog Card (Optional) 
If the Analog Output option was purchased with your system, then open the EyeLink II 
Host PC, and insert the insert the Data Translation Analog Card into a free PCI slot. 
Ensure the card’s bracket is firmly attached to the PC. 

 

                  Figure 1-3 Analog Card 

1.3.3 Headband Installation 

IMPORTANT: Do not let the headband 26-pin connector receive an electro-
static shock from a carpeted floor or similar surface. 

 
Remove the EyeLink II headband and cable from the case.  Remove the cable tie from 
the headband cable.  Hold the headband by the top clamp while gently letting the cable 
fall free, and allowing any twists in the cable to straighten.  It is very important to avoid 
twists in this cable, as these will stiffen it and may shorten its lifespan. Plug the 
headband cable into the large connector on the EyeLink II card (see Figure 1-2), and 
secure with the screw posts (do not over-tighten, this is just to prevent connector from 
coming loose).  Ensure the cable is laid out where it will not be twisted, stood on or 
rolled over by chairs, etc. 

1.3.4 Marker Cable installation 
Unpack and straighten the marker cable.  Attach the 4 supplied Velcro patches to the 
corners of the Display monitor as illustrated in Figure 1-4.  Route the marker cable 
behind the monitor, and run the 4 separate wires along the sides of the monitor.  
Attach the 4 markers to the Velcro patches, and dress wires as desired. Plug the 
marker cable into the second connector on the back of the EyeLink II card, and secure 
with the screw posts (do not over-tighten, this is just to prevent connector from coming 
loose). 

1.3.5 Ethernet Cable 
Unpack the supplied Ethernet cable, and plug the end with the black box into the 
Ethernet jack (between the two cables) on the back of the EyeLink II card.  The supplied 
cable should connect directly to an Ethernet card in the display PC without using a 
hub.  You will need a different cable and a low-speed hub to connect the EyeLink II 
card to multiple display computers.  It is not recommended to use a high-speed or 
multi-speed hub, as this will cause dropped packets. 
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Figure 1-4:  Marker Set-up on EyeLink II Display Monitor 

1.3.6 EyeLink II System Cabling 

For system set-up, please follow the wiring diagram in Figure 1-5. 

The basic cabling steps are: 

1. Plug the cable from the monitor markers into the 9-pin connector on the back of 
the EyeLink II card. 

2. Attach one end of the Ethernet crossover cable to the Ethernet port on the 
Display PC that is to be configured and used with the EyeLink II. Plug the other 
end of the Ethernet cable into the Ethernet port of the EyeLink II card of the 
Host PC. 

3. Plug the EyeLink II headband cable directly into the EyeLink II adapter 
connector on the back of the PC.  

4. Plug the supplied USB Button Box into a USB port on the back of the Host PC 
as indicated by a label. If no label is present use any open USB port. On the Dell 
Optiplex, use a USB port on the front of the computer. An optional USB 
extender cable is included if the Button Box needs to be further than three feet 
from the Host PC. 

 

NOTE: The USB Button Box must be directly connected to a USB port on 
the Host computer and cannot be connected through a USB hub. 

IMPORTANT: Please be sure to use the PS/2 keyboard and mouse supplied 
with your Host PC. 
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Figure 1-5:  System Set-up and Cabling 

1.4 Host PC Software Installation 

Both the Host PC and Display PC need to be configured for use with the EyeLink II 
system. Host PC software installation  

If you received a preconfigured Host PC then the Host PC is already installed and you 
may skip this section. 

If you need to install the Host PC software, the first step in preparing your Host PC for 
the EyeLink II is to install the ROMDOS operating system that the EyeLink II system 
runs on. Once you have installed ROMDOS on its own partition along with Windows, 
you can access the EyeLink partition through Windows Explorer.  

For the following operating systems please consult the appropriate appendix for 
installation instructions: 

• Windows XP - see Appendix A  
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• Windows Vista – see Appendix B                                                         
Note that for Vista, a clean installation of Vista is required 

1.4.1 Testing the Host PC installation 
The Host PC is now ready to test. Start the EyeLink II Tracker application by typing  

 
T [Enter] 
 
OR 
 
CD C:\EYELINK2\EXE [ENTER] 
EYELINK2 [ENTER] 
 

The EyeLink II Host application should start and you should see the EyeLink II Offline 
screen illustrated in Figure 1-6 (left). If you see solid, darkly colored images, be sure to 
remove the camera covers from the eye cameras on the headband. 
 

  

Figure 1-6: Offline Mode (left) and Camera Setup (right) 

Press [Enter] and you should be taken to the Camera Setup screen where you can see 
the three EyeLink camera images. 

1. Put the headband in front of the head camera markers and see that the head 
camera is picking up the markers. 

2. Put on the headband and see that the eye cameras are picking up image as 
illustrated in Figure 1-6: . 

1.4.2 Host PC Maintenance 

All EDF files that have been created during the recording phase of each experiment will 
be saved to C:\EYELINK2\DATA and log files documenting tracker activity will be saved 
in C:\EYELINK2\EXE. If the hard disk partition becomes too full, the Host software will 
print a warning on startup. It is a good idea to periodically boot into your Windows 
operating system to back up your data periodically and delete unwanted LOG files to 
maintain ample free space for data recording. 
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1.5 Display PC Software Installation and Configuration 

The Display PC is used to run experiment application software for control of the 
EyeLinkII tracker and stimulus presentation through the EyeLinkII API. This API is 
available on Windows, MacOS and Linux platforms. The Display PC installation process 
is much less complicated than the Host PC installation and should not take more than 
15 minutes. Installation instructions for Windows and MacOS X are detailed below. 

1.5.1 Windows Installation 

To use a Windows Display computer with the EyeLink II system, various EyeLink 
software components should be installed. The installation process consists of the 
following basic steps: 

• Install the EyeLink Experiment Programming Kit. 

• Install the supplied IO Port Access Driver if planning to use TTL. 

• Install the EyeLink Data Viewer and / or Experiment Builder software (if 
purchased). 

• Install the USB Key drivers for EyeLink Data Viewer and / or Experiment 
Builder software (if purchased). 

• Configure the network connection to the EyeLink II Host PC. 

1.5.1.1 Installing the EyeLink Experiment Programming Kit 

The Windows toolkit (API and example files) is available on the “EyeLink II Software” CD 
in the “Display PC Installation” directory. To install the toolkit: 

1. Insert the “EyeLink II Software” CD. 

2. Open the “Display PC Installation → Windows” folder. 

3. Run the EyeLinkDevKit_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the display 
software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 
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1.5.1.2 Installing the IO Port Access Driver 

For proper access to IO ports (i.e. for TTL signaling) on the Display PC, an access driver 
must be installed. Note that this PORT95NT installer doesn’t run on any 64-bit versions 
of Windows XP or Vista.  

1. To install the driver, click Start → Programs → SR Research → EyeLink → 
Utilities → PORT95NT. 

2. Follow the on screen instructions. 

3. Reboot your computer when prompted. 

1.5.1.3 Installing the EyeLink Data Viewer and Experiment Builder Software 

The EyeLink Data Viewer and Experiment Builder software are optional Windows 
applications for the EyeLink eye tracker. If you did not purchase these options this 
section may be skipped, or you may install the software for evaluation in demo mode. 

1. Insert the “EyeLink II Software” CD. 

2. Open the “Display PC Installation → Windows-> EyeLink Data Viewer” folder. 

3. Run the EyeLinkDV_*.exe program by double clicking the icon. 

4. Follow the instructions from the InstallShield Wizard to install the software. 

5. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

6. Open the “Display PC Installation → Windows-> SR Research Experiment 
Builder” folder. 

7. Run the SREB_*.exe program by double clicking the icon. 

8. Follow the instructions from the InstallShield Wizard to install the software. 

9. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

1.5.1.4 USB License Key Installation 

If you purchased either the Data Viewer or Experiment Builder software, you will 
have been provided with a USB license key with your order. To install the software 
driver for the USB license key follow these steps: 

1. From the Windows Start menu select “Start->All Programs -> SR Research -> 
Install HASP Driver”. You may also try running both “HASPUserSetup.exe” and 



Introduction 
© 2005-2009 SR Research Ltd. 

11 

 
 

“hdd32.exe” installers contained in the “C:\Program Files\SR 
Research\Common” folder of the display computer. 

2. Follow the instructions from the InstallShield Wizard to install the software. 

3. Wait for the InstallShield Wizard to finish, and click FINISH to complete 
installation. 

4. Insert the USB Key into an available USB port on the Display computer. The 
USB key should start to glow red, indicating that the key has been recognized 
by the system.  

1.5.1.5 Setting up EyeLink II Network Connection 

You must have an Ethernet port in your Display Computer. Allow Windows to install 
drivers for it (if it is new hardware), then follow these instructions to install and 
configure the TCP/IP network protocol. These instructions are based on Windows XP; 
other Windows operating systems may vary slightly. 

1. From the Start menu select the Control Panel. 

2. Click on the Network and Internet Connections icon, and then select the 
Network Connections icon. Check the list of installed components to make sure 
a network card is installed. If not, install a driver for the card. 

3. Double click on the network card icon that represents the network card that will 
be connected to the EyeLink II Host PC. 

4. Select the properties button. 

5. Check that “TCP/IP” is displayed in the list of components and that it is 
checked. If not, press the checkmark beside the option.  

6. Select the “TCP/IP” component for the Ethernet card connected to the eye 
tracker PC, then click on the “Properties” button.  

7. Select the “Use the following IP address” radio button. Enter the IP address of 
“100.1.1.2”. The last digit of the IP address can increase for other computers 
on the EyeLink network. Enter the subnet mask of “255.255.255.0”. Leave the 
default gateway and other settings blank.  

8. Click on “OK” to return to the Properties dialog. Click “OK” again to save your 
changes. Click “Close” to exit from the network card dialog. 

If connectivity error messages appear ensure the supplied Ethernet crossover cable 
connects the configured Ethernet port of the Display PC to the EyeLink II card of the 
Host PC. Alternatively, you may need to reinstall the network card drivers. To be safe, 
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open the Network dialog and remove all components, restart Windows, then install the 
network card driver and the TCP/IP protocol again.  

To test the network, start the EyeLink II tracker and start the “Track” application from 
“Start -> Programs -> SR Research -> EyeLink -> Track”. The link should connect, and 
the screen will display instructions. This application allows you to practice participant 
setup and test the system, as described in the EyeLink II Installation Guide.  

If the message “Cannot initialize link” appears, the TCP/IP protocol or crossover cable 
is/are not properly configured. If the connection times out, it is probably due to the 
network card being improperly configured or because the network cable is not 
connected to both PCs. On the Host PC, the Ethernet cable should be connected to the 
EyeLink II card (not to any other Ethernet ports!).  

1.5.1.6 System and Programming Tools Required 

The C experiment templates in Windows Display Software package were developed 
using Microsoft Visual C 6.0. Other 32-bit C and C++ compilers may be used, but you 
will have to translate the included make files to rebuild the experiments. This release of 
the Windows Display Software does not supply examples for C++ programming. 

1.5.2 Mac OSX Installation 

To use Mac OSX as a Display computer with the EyeLink II system, various EyeLink 
software components should be installed on the computer. The installation process 
consists of the following basic steps: 

• Install the “Mac OSX Display Software”. The installer disk image is located in 
the “Display PC Installation/Mac OSX” folder of the “EyeLink II Software” CD 
– the latest version of the software can be downloaded from SR Research 
Support website (https://www.sr-
support.com/forums/showthread.php?t=15).  

Mount and open the disk image under MacOS, then click on the installer 
and follow the instructions, using the default settings as prompted. The 
EyeLink libraries, documentation and source code examples are installed in 
the Applications:EyeLink folder. 

• Install the EyeLink Data Viewer. The installer disk image is located in the 
“Display PC Installation/Mac OSX” folder of the “EyeLink II Software” CD – 
the latest version of the software can be downloaded from SR Research 
Support website (https://www.sr-
support.com/forums/showthread.php?t=10).  
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Mount and open the disk image under MacOS, then click on the installer 
and follow the instructions, using the default settings as prompted. Data 
Viewer is installed in the Applications:EyeLink DataViewer directory.  

• Install the USB HASP Key driver for EyeLink Data Viewer. Mount the 
“Hdd_MacOSX.dmg” disk image to get access to the HASP driver installer. 
Double click on the installer made available by the disk image and follow the 
instructions, using the default settings as prompted.  

• Configure the network connection to the EyeLink II Host PC. Set the IP 
address to 100.1.1.2 and subnet mask to 255.255.255.0. You can do this by 
opening the System Preferences (Apple menu item, then select ‘System 
Preferences…’) and click on the Network Icon. Next go to your computer’s 
Built-In Ethernet device, select Manually on the Configure pop-up menu, 
and enter the above IP address and subnet mask. Click Apply to apply these 
new settings. 

If you plan to program your experiments in MatLab, install the latest version of the 
PsychToolBox and reboot the computer. Some demo examples can be found in the 
Psychtoolbox directory which is in the Applications folder at: 
"Applications/Psychtoolbox/PsychHardware/EyelinkToolbox/EyelinkDemos/GazeConti
ngentDemos".  
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2. Final Installation Steps 

This section lists the final installation steps to fine tune your EyeLink II installation. 
These steps are important and should be repeated any time that the physical 
configuration is changed. 

2.1 Configuring the PHYSICAL.INI file for standard display monitors 

The EyelinkII PHYSICAL.INI file contains settings that tell the system about the 
physical size of the display monitor. By default the PHYSICAL.INI file is setup to work 
with a 19” display monitor, and no adjustments are required to this file if the target 
system matches this setup. The settings for 17” and 21” monitors are also contained 
within the PHYSICAL.INI file. 
 
The parameters in the PHYSICAL.INI file that change depending on the size of the 
display monitor are: 
 
marker_phys_coord – specifies the physical coordinates of the IR markers, relative to 
the center of the screen. The order of these coordinates is top-left, bottom-left, top-
right, bottom-right and are specified in millimeters. For the default case of a 19” 
monitor this parameter will read. 
marker_phys_coords = -210,140, -210,-140, 210,140, 210,-140 
 
screen_phys_coord – specifies the physical distance of the four edges of the 
presentation surface, to the center of the screen. The order of these measurements is 
left, top, right, bottom and are specified in millimeters. For the default case of a 19” 
monitor this parameter will read. 
screen_phys_coords = -178.0, 135.0, 178.0, -135.0 
 
screen_pixel_coord – specifies the resolution of the display surface. Normally this is 
programmatically adjusted by the EyeLink II API at the start of an experiment. If the 
EyeLink II API is not being used, then default value for this parameter will apply. The 
default value reads.  
screen_pixel_coords = 0.0, 0.0, 640.0, 480.0 
 
To determine the display screen resolution, click anywhere on the Windows Desktop 
and press the mouse right button and select “properties”. Select Display Properties> 
Settings and make a note of the ‘Screen Area’. 
  
Should the target system differ from the default of 19” monitor and 640x480 pixels, the 
PHYSICAL.INI file must be changed. To do this, open the EyeLink II application 
PHYSICAL.INI file by typing the following at the command prompt 
 
 cd c:\eyelink2\exe 

 attrib –R physical.ini 

 edit physical.ini 
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The settings for marker_phys_coords and screen_phys_coords for 17” and 21” 
monitors are already specified in the PHYSICAL.INI file. The user needs only to remove 
the comment from the parameter required for the new setup. To do this. 

1. Go to the marker_phys_coords parameter 
2. Remove the comment by deleting the two semi-colons that precede the required 

parameter 
3. Insert two semi-colons before the old parameter 
4. Repeat steps 1-3 for screen_phys_coords 
5. Repeat steps 1-3 for screen_pixel_coords 
6. Save changes and exit the file 

 
Finish by typing the following at the command type 
 attrib +R physical.ini 

2.2 Configuring PHYSICAL.INI for non-standard display monitors.  

This section details the changes that are required to the PHYSICAL.INI file, should the 
dimensions of the display monitor be non-standard. 
 
All screen marker measurements are in millimeters. It is recommended that a straight 
ruler and a sharp pencil be used to mark a reference line, half-way between the IR 
markers, on either side of the plastic surface of the monitor outer casing. These marks 
are required for accurate display screen measurement, and should be removed after the 
PHYSICAL.INI file has been successfully amended. 
 

IMPORTANT: If a display computer is not being used, then non-permanently mark the middle of the 
Display and follow the steps within this section of the manual.  Use the pencil marked point as if it was 
the drift dot generated by the Display PC in track.exe. 

 
Turn on both the EyeLink II Host and Display PC and run track.exe on the Display PC.  
Type in “123” for the saved EDF file name and click the OK box. Press “Enter” on either 
keyboard twice.  
 
On the Host PC go to “Set Options” on the screen and select “mouse simulation” mode.  
This will now let you use the Host PC mouse to simulate eye movements.  Check that 
the Calibration Type is set to a nine-point pattern.  Press “Previous Screen” button to 
return to the camera setup screen. 
 
Now press “C” or the calibration button.  A calibration dot should appear on the middle 
of the display monitor.  Use this dot as the central reference point for all horizontal and 
vertical PHYSICAL.INI measurements. 

2.2.1 Measuring the marker_phys_coords 
 
Ideally the IR markers should be placed on the screen as illustrated in Figure 2-1. 
Obtain the measurements as described in the following steps and record these values 
for inclusion into the PHYSICAL.INI file. 
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Figure 2-1:  Marker Set-up on EyeLink II Display Monitor 

Step 1: 
Measure the distance from the calibration dot, to the reference line in the middle of the 
IR markers(1). Also, record half the distance between the IR markers(2) This is 
illustrated in Figure 2-2. 
  

 

Figure 2-2:  Marker_Phys_coords 1,2 

 
Step 2: 
Measure the distance from the calibration dot, to the reference line in the middle of the 
IR markers(3). Also, record half the distance between the IR markers(4) This is 
illustrated in Figure 2-3 

      

Figure 2-3:  Marker_Phys_coords 3,4 

Step 3: 
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Measure the distance from the calibration dot, to the reference line in the middle of the 
IR markers(5). Also, record half the distance between the IR markers(6) This is 
illustrated in Figure 2-4. 

 
 

Figure 2-4:  Marker_Phys_coords 5,6 

Step 4: 
Measure the distance from the calibration dot, to the reference line in the middle of the 
IR markers(7). Also, record half the distance between the IR markers(8) This is 
illustrated in Figure 2-5. 

 

Figure 2-5:  Marker_Phys_coords 7,8 

The new settings for the marker_phys_coords in the PHYSICAL.INI file are determined 
by 
marker_phys_coords = -1,2, -3,-4, 5,6, 7,-8 

2.2.2 Measuring screen_phys_coords 
 
In the screen_phys_coors, measure the distance from the center of the dot to the end 
of the active part of the monitor screen. Start on the left side(S1) and follow round to 
the top(S2), right(S3) and bottom(S4). This is illustrated in Figure 2-6. 
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Figure 2-6: Measuring screen_phys_coords 

The new settings for the screen_phys_coords in the PHYSICAL.INI file are determined 
by 
screen_phys_coords = -1, 2, 3, -4 
 

2.2.3 Entering values into PHYSICAL.INI 
 
The newly acquired values for marker_phys_coords and screen_phys_coords must 
now be entered into the PHYSICAL.INI located on the Host PC. Re-boot the Host PC and 
do not press “T” when in MS-Dos before running the EyeLink II GUI. If you are in the 
EyeLink II GUI press “Ctrl + Alt + Q” or the ‘Exit EyeLink’ Button. 
 
From the command prompt type the following 
 
 cd c:\eyelink2\exe 

 attrib –R physical.ini 

 edit physical.ini 

To enter the new values, follow these steps 
 

1. Go to the marker_phys_coords parameter 
2. Remove the comment by deleting the two semi-colons that precede the ‘for non-

standard monitor’ parameter 
3. Enter new values 
4. Insert two semi-colons before the old parameter 
5. Repeat steps 1-3 for screen_phys_coords 
6. Save changes and exit the file 

 
Finish by typing the following at the command type 
 attrib +R physical.ini 
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3. Appendix A: Windows 2000/XP Host PC Installation 

Please follow the instructions here to install or reinstall the host software. 

IMPORTANT: Before proceeding with the EyeLink II Host software 
installation ensure you have backed up all important data on your Host PC. 

The first step in preparing your Host PC for the EyeLink II is to install the ROM-DOS 
operating system that the EyeLink II system runs on. This allows you to perform 
subject setup, monitor performance, record data, and control experiments running on 
the Display PC. At the same time, you will want to keep your existing operating system 
accessible so that you can access your CD-RW drive etc. when required. To achieve 
this, you will create a FAT32 partition on your hard drive using System Commander 
that will host the ROM-DOS OS provided with your EyeLink II system. System 
Commander will also be used to allow you to choose which operating system you wish 
to launch when you start the Host PC.  

 

Important: If you have a floppy disk drive, 
create the System Commander rescue disks 
when prompted during installation. These may 
help you recover the drive partitions in the 
future, in the event of file system corruption on 
the drive. 

Your System Commander license is registered 
through SR Research Ltd. 

              Figure 3-1: License Code Entry 

Install System Commander 

Install the System Commander application that came with your EyeLink II. This 
application allows the user to manage multiple Operating Systems on one computer.  

1. Boot into Windows as normal. Insert the “EyeLink II Software” CD into your CD 
drive. 

2. Access the CD-ROM contents by double-clicking on “My Computer” and 
selecting the CD-ROM drive. Open the ‘Host PC Installation\Utilities’ folder and 
run the SystemCommander811.exe file to install the System Commander 
software. 
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3. Click the INSTALL button on the opening screen and follow the instructions to 
install the System Commander software. The license number will be on the front 
of the EyeLink II Software CD case – enter it when you see the screen illustrated 
in               Figure 3-1. You are only licensed for 1 copy of this software for use 
on the EyeLink II Host PC. The installer will prompt you to create ‘Rescue 
Disks’, to register, to check for updates from the web, etc. None of these steps is 
critical, so they may be skipped. 

4. After installation, run the System Commander program by going to the Windows 
“Start Menu” and selecting the “System Commander” entry. 

5. A “Utility Wizard” dialog box will automatically be displayed (see Figure 3-2) 
select the “Enable System Commander” entry, click on “Next”, exit the System 
Commander program and restart the computer, booting from the System 
Commander Boot CD supplied.  

 

Figure 3-2: Enable System Commander 

Resize Existing Disk Partition  

The next step is to resize the existing partition to make space for a 5GB EyeLink Host 
Application partition. 

Insert the supplied “System Commander Boot CD” into the CD drive and restart the 
computer, booting from the CD. You may need to configure your BIOS boot order so 
that the CD is first in the Boot Priority. On Dell PCs, Press F12 to get the Boot Menu 
and the select Internal CD as the boot device.  

Once you have booted from the CD, select “Partition Commander or Restart”, and then 
select ‘Manual Partitioning’ as illustrated in Figure 3-3. 
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Figure 3-3: Select Partitioning then Manual Partitioning 

 

 

Figure 3-4: Partition Selection and Resizing 

1. From the ‘Partitioning’ window (left side of Figure 3-4) select the disk and the 
partition to resize. In System Commander, each disk is represented as a 
cylinder. Within these cylinders are differently colored partitions. The 
partition (typically, this will be in the primary disk) that should be resized to 
make a new partition will normally be the largest chunk within the selected 
disk. Highlight this partition as illustrated in left, and then click on the 
“Resize” icon. 

2. In the “New size (MB)” field of the Resize Partition dialog box (Figure 3-4 
right), enter a value that is 5120MB less than the indicated ‘Current Size’. 
For example, if the original disk size is 76253 MB, you should put 71133 MB 
in the new size field. 

3. Press ‘Next’ to do the resizing of the drive. System Commander may adjust 
the partition size you entered slightly. This is expected and is not an issue. 
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Figure 3-5: Partition and Partition Type Selection 

Create the EyeLink II Host Application partition  

1. From the ‘Partitioning’ window select the newly formed ‘Free’ space (highlighted 
in gray) which will appear on the top of the cylindrical drive diagram as 
illustrated in the left side of Figure 3-5. Click the ‘Create’ icon which will bring 
up the ‘Create Partition’ window. 

2. Select ‘Primary’ and click ‘Next’ which will bring up the ‘Create Primary Partition’ 
window as illustrated in the left side of Figure 3-6. In the ‘Volume label’ field 
type EYELINK and ensure that the ‘Custom Partition Type’ box is checked. 
Click ‘Next’ to bring up the ‘Custom Partition Type’ window as illustrated in 
Figure 3-6, right, and select ‘FAT-32’ then click ‘Next’. In the following ‘Warning!’ 
window, click ‘Proceed’. 

 
 

Figure 3-6: Create a Custom FAT 32 Partition 
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3. Close the ‘Partitioning’ window by selecting the red “X” in the top right corner of 
the window and exit System Commander by clicking "Start" at the bottom-left 
corner of the screen selecting the "Exit" option. Eject the CD before the 
computer reboots. 

4. Upon restart the computer will once again run the System Commander 
application. The new EyeLink partition will appear as the icon with two question 
marks and will be labeled ‘FAT-32 OS’ as illustrated in Figure 3-8. We will 
return to deal with this later. For now, we wish to boot into Windows once again. 

5. Select the Windows XP partition. Windows XP should immediately determine 
that the disk partitioning has changed and perform a number of system tests to 
validate the hard drive. This is expected and should not be interrupted.  

6. Windows will reboot once its validation checks have been performed. From the 
System commander menu select Windows XP a second time and boot into the 
Windows operating system. 

Copy the Host Application files to the New Partition  

The next required step is to copy the Host PC application files from the supplied 
“EyeLink II Software” CD onto the newly created EyeLink partition. 

1. From Windows, start Windows Explorer. If you have removed the “EyeLink II 
Software” CD from your CD drive, reinsert it. Navigate to the “Host PC 
Installation \ Host Partition” folder.  

2. Copy all of the files in this folder to the top level of the newly created EyeLink 
FAT-32 drive (often E:\). The EyeLink CD has copy of all the files required for 
the Host partition, including a required camera-specific .SCD file. Hence the CD 
is required, and it is a good idea to keep the EyeLink II Installation CD in a safe 
place. 

In some cases, Windows may hide certain operating system files (i.e., files 
ending in .INI or .BAT). If you do not see a .BAT file when you view the contents 
of the Host Partition folder, you can set Windows to ‘see’ these files using the 
following steps: 

i. Select the Tools → Folder Options… menu in Windows Explorer. 

ii. Select the View tab. 

iii. Select the “Show hidden files and folders” option under Hidden files and 
folders. 
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iv. Ensure “Hide extensions for known file types” is not selected. 

v. Uncheck the “Hide protected Operating system files….” as illustrated in 
Figure 3-7. 

 

Figure 3-7: Windows Explorer Tools Folder Options… 
Dialog 

vi. Press OK. 

vii. Select all files in the “Host Partition” folder of the CD. 

viii. Copy these files to the root directory of the EyeLink II drive on your 
computer. 

3. To return Windows so that it hides operating system files complete the following 
steps: 

i. Select the Tools → Folder Options… menu in Windows Explorer. 

ii. Select the View tab. 

iii. Deselect the “Show hidden files and folders” option under Hidden files 
and folders. 

iv. Check the “Hide protected Operating system files….” 
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Configuring the Keyboard 

The PS/2 keyboard is the default driver setup within the EyeLink Host directory, 
and is the only keyboard hardware recommended for the latest versions of the Host 
Application. 

Transfer the System to make the EyeLink Partition Bootable 

1. Insert the CD labeled “ROM-DOS Boot Disk” that came with the EyeLink II 
system, and restart the system as you normally would via Windows. The next 
step is to boot off of the CD. You may need to press F12 before System 
Commander is run to boot off of the CD-ROM device. With some newer types of 
hardware choosing to boot from the CD-ROM from within System Commander 
does not work as desired. 

2. You will know that you have successfully booted from the CD-ROM of you are 
given a ROM-DOS command prompt. 

IMPORTANT: The following step requires you to determine the correct drive 
letter (c:, d:, etc) for the EyeLink II partition you created above after booting 
with the ROM-DOS Boot Disk. Determine this by using the dir command 
(e.g. dir c:) for each drive to find the EyeLink drive label and substitute 
that drive letter (c:, d:, etc) in place of {EYELINK DRIVE} below. It is likely 
that the drive letter will be either c: or d:  

3. At the command prompt 'A:\>’ type the following command: 

sys {EYELINK DRIVE} [ENTER] 

For example if your EyeLink partition is drive c: you will enter: 

sys c: 

and then press the enter key. 

4. Reboot the computer. Once System Commander runs, you should see 
something like the screen pictured in Figure 3-8 with ?? and FAT-32 describing 
the EyeLink Host partition. 
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Figure 3-8: Select Partition to Rename 

Organize System Commander’s ‘OS Selection Menu’ 

1. When System Commander starts up, you will see a screen similar to Figure 3-8. 
Click on the ‘Settings’ icon. 

2. From the ‘Settings’ window, select ‘Descriptions and Icons’ as illustrated in the 
left side of Figure 3-9. 

3. From the screen in the right side of Figure 3-9, click on the arrow buttons of the 
‘Current Selection’ box to select the ‘FAT-32 OS’. In the ‘EDIT DESCRIPTION’ 
box type EyeLink. Under ‘SELECT ICONS’, use the ’+’ and ‘-‘ buttons to change 
both large and small icons to ‘OS’. 

4. Click ‘OK’ to finish. Then from the ‘Settings’ window, select ‘Order Add and 
Remove’ as illustrated in Figure 3-10. 

5. From the ‘Order Add and Remove’ window, remove all icons except for the 
Windows XP and EyeLink by highlighting each one and clicking the ‘Remove’ 
button as in the right side of Figure 3-10.  

6. Highlight the EyeLink OS and click the ‘Top’ button to make EyeLink the default 
partition. 

7. Click ‘OK’ to finish and close the ‘Order and Remove’ window. 
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Figure 3-9: Select Description and Icons 

  

Figure 3-10: Order Add and Remove 

Automated boot into the EyeLink II Operating System 

1. If you would like System Commander to automatically boot into the EyeLink 
partition, click on ‘Timeouts and default OS’ from the ‘Settings’ window. 

2. Check the box beside ‘Auto-select timeout’ and set the number of seconds for 
System Commander to wait before booting the default operating system. 
Indicate the default OS in the ‘Default OS selection’. If you followed the earlier 
instruction, EyeLink will be the first OS and can be selected by choosing ‘A’. 

3. Once you have completed this step, close the windows by clicking the X in the 
top right corner. You will be returned to the main System Commander window 
and are now ready to test the installation. 
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Appendix B: Windows Vista Host PC Software Installation 

Please follow the instructions here to install the Host software in conjunction with 
Windows Vista. 

IMPORTANT: Before proceeding with the EyeLink II Host software 
installation ensure you have backed up all important data on your Host PC. 

A new Windows Vista installation is required and this WILL erase everything 
on the hard drive. We do not have the ability to separately create the Host 
partition with an already existing Vista installation. 

WARNING: ALL DATA ON THE DISK WILL BE ERASED 

Due to the nature of Windows Vista’s boot loader, a full installation of Windows Vista 
must be performed. This means that the hard drive will be formatted and any 
information on the hard drive will be erased. 

We will first format the hard drive using ROM-DOS and create a FAT32 partition for the 
EyeLink Host software. Next, Windows Vista will be installed on the unused portion of 
the drive. Finally, under Vista, we will configure the boot loader so that the system can 
be booted into either ROM-DOS or Windows Vista. 

You will require: 

• a ROM-DOS Boot CD (supplied with your EyeLink or disk image available via 
support@sr-research.com) 

• a copy of your EyeLink II CD-ROM (or “EyeLink CL” CD-ROM) containing the 
Host PC application software and your .SCD file (supplied with your EyeLink) 

• a copy of your Vista installation disk and Vista License 

Formatting the Hard Drive under ROM-DOS 

The first step in preparing your Host PC for the EyeLink II and Vista is to format your 
hard drive using the ROM-DOS operating system, and creating a partition for the 
EyeLink Host software.  

1. Boot the computer with the ROM-DOS Boot CD. If you are using a Dell 
computer, place the CD in the CD-ROM drive and press F12 for booting options, 
and boot from the Internal or USB CD-ROM drive. For other motherboards and 
systems, you may need to enter the BIOS and change the Boot Priority of the 
different drive components, in order to make the CD-ROM have the highest boot 
priority. 
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2. At the command line prompt type "FDISK" without quotes. 

3. While running FDISK: 

i. type 'A' and delete all partitions 

ii. type 'M' and write the Master Boot Record 

iii. Create a DOS partition that is about 10 GB 

iv. Save and exit 

4. Reboot the computer with the ROM-DOS CD. 

5. At the command line prompt type "FORMAT C:" to format the disk, and label the 
disk “EyeLink” if asked. 

6. At the command line prompt type "SYS C:" to install the ROM-DOS system files 
and make the partition bootable. 

7. Eject the CD from the CD-ROM drive and reboot the computer. If all goes well, 
the system should boot from the hard disk and present a ROM-DOS command 
line prompt. 

The next step is to install Windows Vista on the remainder of the hard drive, and then 
to configure the Boot Loader so that Vista will give the option to boot from the ROM-
DOS partition or Vista when you start your computer. We will also copy the Host PC 
directory and software to the EyeLink partition. 

8. Reboot the computer from the Vista install DVD. 

9. Install Vista on the second partition or if no second partition is shown, on the 
remainder of the drive. 

10. Enter User Names and Passwords as desired and once the Vista installation is 
complete, reboot into the Vista operating system.  

11. Go to the Start / All Programs -> Accessories -> Cmd.exe menu and right click 
on the Cmd.exe icon and select the “Run as Administrator” contextual menu 
item. Issue the following commands from the command prompt: 

i. bcdedit /copy {legacy} /d "EyeLink"  

This will return a “<GUID>” – a string of characters that looks something like 
{xxxxxxxxxxxxxxxxx....xxxx}. Select all of the text in the CMD window and copy it to 
the clipboard by going to the Edit menu and selecting “Copy” – open Notepad in 
Windows which is a simple text editor located at Start /All Programs -> Accessories 
-> Notepad, and paste the text from CMD into the empty document. You can now 
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highlight and copy just the <GUID> text so that it can be easily pasted in the 
following steps, wherever <GUID> appears. 

ii. bcdedit /set <GUID> device partition=D: 

iii. bcdedit /set <GUID> path \bootsect.bak 

iv. bcdedit /displayorder <GUID> /addfirst 

v. bcdedit /default <guid> 

12. Reboot the computer and select "Eyelink" on the menu to go into the EyeLink 
partition or select Windows Vista to boot into Vista. You can now copy the EyeLink Host 
Partition files from your EyeLink II (or EyeLink CL) distribution disk to put the host 
software on the EyeLink partition. See Section 11.4 "Copy the Host Application files to 
the New Partition" for instructions. 

 

 


